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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page nhumber. The humbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP3422 Evaluation Board. ltems discussed in this chapter include:

» Document Layout

» Conventions Used in this Guide

» Recommended Reading

» The Microchip Web Site

» Customer Support

» Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP3422 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

+ Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP3422 Evaluation Board and instructions on how to use theMCP3422
Evaluation Board with PICkit™ Serial Analyzer.

» Appendix A. “Schematic and Layouts” — shows the schematic and layout
diagrams for the MCP3422 Evaluation Board.

« Appendix B. “Bill Of Materials (BOM)” — lists the parts used to build the
MCP3422 Evaluation Board.

© 2008 Microchip Technology Inc. DS51781A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description | Represents Examples
Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris theradixand nis a
digit.

40010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0|1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)

{
}

DS51781A-page 2
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Preface

RECOMMENDED READING

This user's guide describes how to use MCP3422 Evaluation Board. Other useful
documents are listed below. The following Microchip documents are available and
recommended as supplemental reference resources.

PICKkit™ Serial Analyzer User’s Guide, DS51647

Consult this document for instructions on how to use the PICkit Serial Analyzer hardware
and software.

MCP3422 Data Sheet, “18-Bit, Multi-Channel AX Analog-to-Digital Converter with
IC™ Interface and On-Board Reference”, DS22088

This data sheet provides detailed information regarding the MCP3422 product family.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

» Field Application Engineer (FAE)
 Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY
Revision A (November 2008)

« |nitial Release of this Document.

© 2008 Microchip Technology Inc. DS51781A-page 3
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MCP3422 EVALUATION BOARD FOR
MICROCHIP PICkit™ SERIAL USER’S GUIDE

Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP3422 Evaluation Board and
demonstrate how to use it with the PICkit™ Serial Analyzer (P/N: DV164122).

The following topics are covered:

+ Description of the MCP3422 Evaluation Board
* How to use the MCP3422 Evaluation Board with the PICkit Serial Analyzer

1.2 DESCRIPTION OF THE MCP3422 EVALUATION BOARD

The MCP3422 Evaluation Board (P/N MCP3422EV) contains a MCP3422 18-Bit
Delta-Sigma Analog-to-Digital Converter (ADC). The MCP3422 is a 2-channel ADC
device with various options. The MCP3422 Evaluation Board has analog input
connection pads and Vpp, SDA, and SCL test pads. The user can connect inputs and
test the conversion results using the PICkit Serial Analyzer and its PC graphic user
interface (GUI). The MCP3422 Evaluation Board has the following interface:

+ PICkit Serial Analyzer for writing configuration register bits and reading the
conversion data.

Note: The MCP3422 Evaluation Board can be used without the PICkit Serial
Analyzer as long as the Vpp, SCL, and SDA are provided to the board. The
MCP3422 Evaluation Board does not include MCU.

The user can monitor the 12C communications by connecting an oscilloscope to the
SDA and SCL test pads. Refer to Appendix A. “Schematic and Layouts”.

1.21  I12C Address Bits for the MCP3422
The I2C device code and address bits of the MCP3422 device are programmed at
factory:

 Device Code: *1101"

» A2, A1, A0 Address Bits: the MCP3422 device in the MCP3422 Evaluation Board
uses default setting: (A2, A1, A0) = (0, 0, 0)

» Address Byte = 1101000R/W

© 2008 Microchip Technology Inc. DS51781A-page 5



MCP3422 Evaluation Board for PICkit™ Serial User’s Guide
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FIGURE 1-1:

Front View of the MCP3422 Evaluation Board.

1.3 GETTING STARTED WITH THE PICKIT SERIAL ANALYZER
Figure 1-1 shows the MCP3422 Evaluation Board and Figure 1-2 shows the MCP3422

Evaluation Board and PICkit Serial Analyzer.
The following instructions describe how to use them together:

1. Connect the MCP3422 Evaluation Board’s 6-pin socket to the PICkit Serial

Analyzer, as shown in Figure 1-2.

2. Connect the oscilloscope probes to the SCL and SDA test pins (optional).

3. Vpp Selection: You can use the Vpp from the PICkit Serial Analyzer or you can
use your own external Vpp. The JP1 connector selects the Vpp path.

(a) Connect JP1, if using Vpp from PICkit Serial Analyzer.

(b) Disconnect JP1 and apply Vpp at VDD1 pin, if you are using an external Vpp.

4. Connecting Vpp: LED D1 turns on when Vpp is applied. The PICkit Serial
Analyzer will provide Vpp automatically, if it is connected to the PC. Make sure
LED D1 turns on, when you execute the command using the PICkit Serial

Analyzer.

5. Connecting the analog inputs: If you need to measure a single-ended input,

connect the unused pin (example, CHX-) to Vgs.

« Connecting the inputs: The MCP3422 Evaluation Board has input pads for
analog inputs for each input channel. You can connect all inputs at the same time
and multiplex the input channel using configuration register settings. You can also
leave the unused channel inputs floating.

DS51781A-page 6
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Quick Start Instructions

6. Use the PICKit Serial Analyzer PC GUI to send 12C write and read commands.

CAUTION

Each analog input pin has an ESD diode. Certain input conditions can damage the
device. Please follow the conditions below:
(a) Do not apply an input greater than the input range specified by the MCP3422 Data
Sheet.
(b) Apply the input signal after Vpp is powered-up.

Personal Computer

USB Cable
Connected between the

PICKkit Serial analyzer
and Personal Computer

PICkit Serial Analyzer ———9

MCP3422
Eval board

‘ CH2~ =a \
Sensor Input _ ow g Sensor Input
Connectors N Connectors
MCP3422 Evaluation Board
FIGURE 1-2: MCP3422 Evaluation Board with the PICkit Serial Analyzer.

© 2008 Microchip Technology Inc. DS51781A-page 7
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1.3.1 PICKkit Serial Analyzer PC Software Setup for the MCP3422
Evaluation Board

The following steps describe how to set up and use the PICkit Serial Analyzer PC
Graphic User Interface (GUI).

1. Install the PICkit Serial Analyzer software onto your personal computer (PC).

2. Connect the USB cable between the PICkit Serial Analyzer and the PC.

3. Runthe PICkit Serial PC Software. The following graphic user interface (GUI) will
appear.

Configuration Wizard m

Welcome To The
PICkit Serial Analyzer
Configuration Wizard

'k The following steps will guide vou through the
@ zetup af the PICKit Senial Analyzer.

| et » | Cancel

FIGURE 1-3: PICKkit Serial Analyzer Configuration Wizard Welcome Window.

Click the Next button and follow the instructions.

DS51781A-page 8 © 2008 Microchip Technology Inc.
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4. Select the Communication Mode type: 12C Master, and click the Next button.

Configuration Wizard H

Communication Mode - Page 1 of 4

Chooze which mode of communication you wish bo uze,

)

|2C Master

" 5Pl Magter

" USART Async

= USaRT Sync hazter

4 Back Mest » Cancel

FIGURE 1-4: Step 1 - Communication Mode Selection.
5. Select 100 kHz or 400 kHz. Either one will be fine. Click the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4

Select your 12C communication speed

Communication speed may also be
" 100 kH= adjuzted by uzirg the '"Configure
o 400 kHz tode' page from the 'PICkit Serial
Analyzer' menu dropdown after
completing the Configuration
Wizard.

< Back Mest » Cancel

FIGURE 1-5: Step 2 - PC Communication Speed Window.

Note: The MCP3422 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICkit Serial Analyzer supports the 1C bus data rate
up to 400 kHz only.

© 2008 Microchip Technology Inc. DS51781A-page 9
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6. Select No on the Enable Pull-ups screen and click the Next button.

Note: The MCP3422 Evaluation Board has its own pull-up resistors.

Configuration Wizard E

Device Fullups - Fage 3 of 4
Do wou need to enable pullups for your device?

Enable Fullups

" Yes f*+ Mo
« Back Mext » Cancel
FIGURE 1-6: Step 3 - Device Pullups Window.
7. Select the Vpp voltage of the MCP3422 Evaluation Board and click the Next

button.

Case 1: When using Vpp from the PICKkit Serial Analyzer:

If you choose PICKkit Serial will power your device and 5 Volt as shown in
Figure 1-7, the MCP3422 Evaluation Board will be powered by the 5V DC from
the PICKit Serial Analyzer through the JP1 jumper. In this case, make sure that
the JP1 jumper on the MCP3422 Evaluation Board is connected.

Case 2: When using your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at the VD1
test point. In this case, make sure that the JP1 jumper is disconnected.

DS51781A-page 10 © 2008 Microchip Technology Inc.
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Configuration Wizard E

Yoltage Source - Page 4 of 4

Does PICKR Seral need to power your device?

Walkage

FICKit Serial wil

power my device ) L
[f PICkit Serial will power your

=  Ghnolt device, select the checkbox ta
™ Dther the left, then determine wor
waltage.

5.0

< Back et > Cancel

FIGURE 1-7: Step 4 - Voltage Source Selection Window.

8. Click the OK button. You have made all the PICkit Serial Analyzer configuration
setups. You are now ready to program the MCP3422 Evaluation Board using the
PICkit Serial Analyzer.

Configuration Wizard m

You're Donel

Prezs '0F' to complete the Configuration ‘wizard.

[ Do not show this wizard on starkup again

wizard may be accessed anvtirme fram
mend dropdown PICK Serial Analyzer -
Run Configuration 'wizard.

ok

FIGURE 1-8: Configuration Wizard - Finishing Step.

© 2008 Microchip Technology Inc. DS51781A-page 11
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1.3.2 Creating Script Files

In order to make a communication connection between the PICkit Serial Analyzer and
the MCP3422 Evaluation Board, a script file is needed. The following procedure shows

how to create script files and how to use them.

* In the PICKit Serial Analyzer window, select from the menu Communications>

Script>Script Builder (Figure 1-9).

Basic Operations

t
i
il
i1

il P|Ckit Serial - 12C Master Mode !

Communications | PICk Serial Analvzer  DemoBoards  User Defined Templates  Wiew  Window  Help

sic Operations | Reset 12C_M

Script 3

M Transactions

File » Edit » Clear

Basic View Set.

Seript Builder | . Aalus

02/13,/2007 4:59:14 PM

wWelcome to PICkit Serial wersion 2.0.1.0
Found PICkit5.d11 - Ver: 1.3.0.0

Found PICkit Serial Analyzer - FWw Ver: Ox0108

UsE control block updated with preference data.

I Update

B Enecutive Error
B Communication Errar

I I12C Error
HEH BitRate: 100.0kHz
Source Woltage: 4.8%

Data Line Woltage: 4.8%
Clock Line Woltage: 4.7%

Script Execute

FIGURE 1-9:

Creating a Script File with Script Builder.

1.3.2.1  CREATING A SCRIPT FILE FOR CONFIGURATION BYTE WRITING

1.

Click on WriteBlockAddrA8 in “Example I2C Scripts” column.

This will result in filling in the spaces under the “Script Detail” column. You can
now modify the “Script Detail” column parameters by right-clicking the mouse.

How to modify the parameters box in Script Details:

1.
2.

3.

Under the “Script Detail” box, select the item in the parameter box.

Right-click the mouse button and an option box appears to the right of your
selection, displaying the options available for the selected parameter.

Select the desired option and delete or insert the parameter box.
Keep the parameters in the order shown in Figure 1-10.

DS51781A-page 12
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idl P|Ckit Serial - 12C Masier Mode

Commnications  PICKDt Serid Analyzer Demo Boards  User Defined Templates  Yiew  Window  Help

View: Basic | Communications: Basic Operations | Reset

1
x

Script Builder

Example [2C Scriptz Script Detail Izer [2C Scripts
Script M ame R eaddddrsd |I2EST.-‘1'-HT il
MCP3422 i iteading
| === ‘wiiteBlockAddi g I 2CWRTEYT
N ReadBlockiddid B ||:|:2
| Cave Scnpt | X
/-’|'DI:I ¥
Execute Script | |EII: "
_ |1.  Tochange value:
Clear Scapt + Click this box and type a ||2|:5T oF —
- 1 new number. | "
2. To delete or insert box:
Del User Scripl + Choose the box and w

right-click the mouse button for

options available

3. Make sure the listed parameters |

M. in “Script Detail” should be in | =
exact order as shown here. |

L4

| x

| x

| ol [
I e—————————————————————
FIGURE 1-10: Modifying Parameters in Script Builder Window.

4. Change the parameter value.

Script Detail

[2CSTART *

I2CWRTBYT | *

[0~ [— > This means there are two bytes to send

po | e > 1st Write Byte: Address byte with W/R bit = 1101-0000
ocC | e > 2nd Write Byte (Configuration Byte): 1001-1100

[2CSTOP *

Note: All 6 parameters above must be listed in the same order as shown here.
The parameters above with * are not modifiable.

© 2008 Microchip Technology Inc. DS51781A-page 13
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«dll P|Ckit Serial - 12C Master Mode

Communications  PICkik Serial Analyzer  Demo Boards  User Defined Templates  Wisw  Window  Help

View: Basic | Communications: Basic Operations | Reset

Script Builder - x
Example |2C Scripts Script Detail Izer |2C Scripts
Scrpt Name F" 12CSTART = MCP3422_wite
MCP3422_wiit Wt
| = WiiteBlockAddiAg IZCWRTEYT
. ReadBlockaddriad |EIE -
Save Script
. 2 Bytes to send |DD *
Ezecute Script P "
Clear Script 12C5TOP |

Address Byte

Del User Scripts Configuration Byt
(9C)

Show Array

| x

| x

ol [~

Note: The “9C” in the configuration byte selects the following options:
- Conversion Mode: Continuous Conversion
- Channel Selection: Channel 1
- Bit Resolution: 18 bits
- Gain Selection: 1x

FIGURE 1-11: Script File Example for the FC Write Command.

DS51781A-page 14 © 2008 Microchip Technology Inc.
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1.3.2.2  SAVING THE SCRIPT FILE AND PROGRAMMING THE MCP3422
CONFIGURATION REGISTER

1. Change the 2nd and 3rd data bytes you want in the Script Detail.

2. Type in any script name (i.e., MCP3422_Write) in the space below the Script
Name menu.

3. Click the Save Script button.
4. Click the Execute Script button.

Note: At this point, the PICkit Serial transmits the I°C Write Command to the
MCP3422 device. The saved file name will appear in “Users 12C Scripts”
column, and can be re-used any time by selecting the file name.

5. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and re-check the parameter values
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 12C
command.

TR TR T T T

Write Command with Address bits Configuration Bits

FIGURE 1-12: FC Write Command Waveforms for the MCP3422.

© 2008 Microchip Technology Inc. DS51781A-page 15
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1.3.3 Reading the Conversion Data using the PICKkit Serial Analyzer

You can read back the conversion data by following the next steps.

1.3.3.1  CREATING A SCRIPT FILE TO READ THE CONVERSION DATA

1. Click on ReadAddrA8 in “Example 12C Scripts” column.

This will result in filling in the spaces under the “Script Detail’column. Now you

can modify the parameter boxes (delete or insert) in the “Script Detail” column

with options. The list of options will appear if you click with the right mouse button
on the parameter box. You can delete the parameter box or add a new one.

2. Make sure the Script Detail parameters are listed in order as follows:

Script Detail

[2CSTART *

[2CWRTBYT *

ot | - > This means there is one byte for address
Dt | - > Address byte with W/R bit = 1101-0001
[2CRDBYTNLB | *
5 | - > 5 bytes to read
[2CSTOP *

Note: All 7 parameters above must be listed in order. The parameters above with
* are not modifiable.

adl PICkit Serial - 12C Master Mode

Communications  PICKE Serial Analyzer  Demo Boards  User Defined Templakes  Wiew  Window  Help

View: Basic | Communications: Basic Operations | Reset

Script Builder -

Ewxample |2C Scripts Script Detail Ideer |2C Scripts

Script Name Readdddrd I MCP3422 wiite
|M CP2422 Pead Wr!te.ﬁ.ddr.-’-'-ﬂ ||2I:ST'&'HT MCP3422 Read
- wiriteBlockAddia® I2CWRTEYT
i ReadBlockdddrdd ||:|2

Save Script | x

i D1 x

Execute Scrnpt |I2EHDBYTNLB

Clear Script | Address Byte |5 | |

l2C5TOP

Del User Scripts | Requesting | ®

5 Bytes | -

Show Array | | «

| x

| ®

| x
| X

FIGURE 1-13: Script File Sample to Read Conversion Data.
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3. Type in any script name (i.e., MCP3422_Read) in the space below the Script
Name menu.

4. Click the Save Script button.
5. Click the Execute Script button.

Note: Atthis point, the PICkit Serial transmits the |°C Read Command to the
MCP3422 device. The saved file name will appear in the “Users 12C
Scripts” column, and can be re-used any time by selecting the file name.

6. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the Execute Script menu, the “Busy” LED on the PICkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and re-check the parameter values,
including the order of parameters under the “Script Detail” column, and try
again until the “Busy” LED turns OFF immediately after sending the 12C
command.
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all P|Ckit Serial - 12C Master Mode

Communications  PICKE Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window  Help

View: Basic | Communications: Basic Operdtions | Reset

Script Builder -|a xl
— Ewample 12C Scriptz —— [ Senpt Detall ———— 1 Ueer I2C Scriptz
Script Mame Readdddit 8 I MCP3422 'wiite
IM CP2427 Read WiriteAddras 2 el MCP3422 Read
- WriteBlockbddidg [ZCwWRTEYT
i ReadBlockdddriad 0
Save Script | *
- 01 x
Execute Scnpt | [2CRDEYTHLE
Clear Script | Address Byte ’ 5 x
[2C5TOF
Del User Scnpts | Re&_’qlB-I;‘tS;Isng x
=
Show Array | "
=
o
x
b4

e

File ~ Edit ~ Clear

10:24 44 AM sent script from Script Builder page, 10
bytes:

[53 041 03] [p0] (RN [0 [P S e st e atand

(=_J[oo] Fe] @7l 1T [oC] [P_]

5th Byte: Repeated Byte for Configuration byte
4th byte: Configuration Byte (note that RDYbit is “0”)
3rd byte: Data Byte

2nd byte: Data Byte
1st byte: Data Byte
esults:

Output code: F907 in hex (= 63751 in decimal)

Output Voltage= 63751 x 15'62‘2 GVA LSB) _ (.996 Volts with PGA= 1

Note that if the differential input voltage is negative (CH- > CH+), the MSB of the first byte will be "1". In this case, the
voltage is calculated after converting the output code to 2's complement and then multiply the LSB.

See Section 4.9 of the MCP3422 Data Sheet (DS22088) for more information.

FIGURE 1-14: Reading Conversion Results. Note that the Input = 0.996V is applied at Ch.1. The
reading indicates the measured value is 0.996 Volts.
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-
4

Data Bytes = 00F907 (hex)

(a) Read command and outputs. The 3 data bytes are zoomed in for better clarity.

Zoom-in

o L prm

Configuration Byte (4th) and Repeated Configuration Byte (5th)

(b) Read command and outputs. The last two data bytes are zoomed in for better clarity.

FIGURE 1-15: Read Command and Data on I°C bus. Note the RDY bit in 4th byte is “0”. This means
the conversion data just read is the latest conversion data. The RDY bit becomes “1” in the 5th byte

(repeated byte). This means the device is now in the process of new conversion and the new result is not
ready yet.
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1.3.4 Experiment with inputs at CH2

Repeat instructions from Section 1.3.2 “Creating Script Files” to
Section 1.3.3 “Reading the Conversion Data using the PICkit Serial Analyzer” for

the Channel 2 input.

Note: To write the configuration register for channel 2 input, you can just use the
“MCP3422_Write” file and modify the configuration byte data only.

To read the conversion data, use the same script file for all channels.
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Appendix A. Schematic and Layouts

A.1  INTRODUCTION

This appendix contains the following schematics and layouts for the MCP3422
Evaluation Board:

+ Board — Schematic

» Board — Top Layer

» Board — Top Metal Layer

» Board — Bottom Layer

© 2008 Microchip Technology Inc. DS51781A-page 21



	Contact us
	Preface
	Introduction
	Document Layout
	Conventions Used in this Guide
	Recommended Reading
	The Microchip Web Site
	Customer Support
	Document Revision History

	Chapter 1. Quick Start Instructions
	1.1 Introduction
	1.2 Description of the MCP3422 Evaluation Board
	1.3 Getting Started with the PICkit Serial Analyzer


